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Vision of the Institute 

 

“Bharath Institute of Higher Education & Research (BIHER) envisions and constantly strives to provide 

an excellent academic and research ambience for students and members of the faculties to inherit 

professional competence along with human dignity and transformation of community to keep pace with 

the global challenges so as to achieve holistic development.” 

 

Mission of the Institute 

 To develop as a Premier University for Teaching, Learning, Research, and Innovation on par with 

leading global universities. 

 To impart education and training to students for creating a better society with ethics and morals. 

 To foster an interdisciplinary approach in education, research and innovation by supporting 

lifelong professional development, enriching knowledge banks through scientific research, 

promoting best practices and innovation, industry driven and institute-oriented cooperation, 

globalization and international initiatives. 

 To develop as a multi-dimensional institution contributing immensely to the cause of societal 

advancement through spread of literacy, an ambience that provides the best of international 

exposures, provide health care, enrich rural development and most importantly impart value 

based education. 

 To establish benchmark standards in professional practice in the fields of innovative and 

emerging areas in engineering, management, medicine, dentistry, nursing, physiotherapy and 

allied sciences. 

 To imbibe human dignity and values through personality development and social service 

activities. 
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B.Tech- Aerospace Engineering 

 

Vision of the Department 

Department of Aeronautical Engineering will endeavor to accomplish worldwide recognition with a focal 

point of Excellence in the field of Aeronautics by providing quality Education through world class 

facilities, enabling graduates turning out to be Professional Experts with specific knowledge in 

Aeronautical & Aerospace engineering. 

 

Mission of the Department 

 To be the state of art Teaching and Learning center with excellent infrastructure and empowered 

Faculties in Aeronautical & Aerospace Engineering. 

 To foster a culture of innovation among students in the field of Aeronautics and Aerospace with 

updated professional skills to enhance research potential for sponsored research and innovative 

projects. 

 To Nurture young individuals to be knowledgeable, skillful, and ethical professionals in their 

pursuit of Aeronautical & Aerospace Engineering.  
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B.Tech- Aerospace Engineering 

 

Program Educational Objectives Statements (PEO) 

 

PEO 1: Demonstrate a solid grasp of fundamental concepts in Mathematics, Science, and Engineering, 

essential for effectively addressing engineering challenges within the Aerospace industry. 

PEO 2: Involve in process of designing, simulating, fabricating, testing, and evaluating in the field of 

Aerospace. 

PEO 3: Obtain advanced skills to actively engage in research and development endeavors within 

emerging domains, while also pursuing further education opportunities. 

PEO 4: Demonstrate efficient performance both as independent contributors and as valuable team 

members in diverse multidisciplinary projects. 

PEO 5: Embrace lifelong learning and career advancement while adapting to the evolving social demands 

and needs. 
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B.Tech- Aerospace Engineering 

Programme Outcomes (PO’s) 

PO1: Engineering knowledge: Apply the knowledge of mathematics, science, engineering 

fundamentals, and Engg. Specialization to the solution of complex engineering problems. 

PO2: Problem analysis: Identify, formulate, research literature, and analyze engineering problems to 

arrive at substantiated conclusions using first principles of mathematics, natural, and engineering 

sciences. 

PO3: Design/development of solutions: Design solutions for complex engineering problems and design 

system components, processes to meet the specifications with consideration for the public health and 

safety, and the cultural, societal, and environmental considerations. 

PO4: Conduct investigations of complex problems: Use research-based knowledge including design 

of experiments, analysis and interpretation of data, and synthesis of the information to provide valid 

conclusions. 

PO5: Modern tool usage: Create, select, and apply appropriate techniques, resources, and modern 

engineering and IT tools including prediction and modeling to complex engineering activities with an 

understanding of the limitations. 

PO6: The engineer and society: Apply reasoning informed by the contextual knowledge to assess 

societal, health, safety, legal, and cultural issues and the consequent responsibilities relevant to the 

professional engineering practice. 

PO7: Environment and sustainability: Understand the impact of the professional engineering solutions 

in societal and environmental contexts, and demonstrate the knowledge of, and need for sustainable 

development. 

PO8: Ethics: Apply ethical principles and commit to professional ethics and responsibilities and norms 

of the engineering practice. 

PO9: Individual and teamwork: Function effectively as an individual, and as a member or leader in 

teams, and in multidisciplinary settings. 

PO10: Communication: Communicate effectively with the engineering community and with society at 

large. Be able to comprehend and write effective reports documentation. Make effective presentations 

and give and receive clear instructions. 

PO11: Project management and finance: Demonstrate knowledge and understanding of engineering 

and management principles and apply these to one’s own work, as a member and leader in a team. 

Manage projects in multidisciplinary environments. 

PO12: Life-long learning: Recognize the need for and have the preparation and ability to engage in 

independent and life-long learning in the broadest context of technological change.  
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B.Tech- Aerospace Engineering 

Program Specific Outcomes (PSO) - R2020 

 

PSO1:  Design and analyze aerospace components/systems for aerospace industries. 

PSO2: Acquire the concepts of spacecraft attitude dynamics for the prediction of spacecraft motion. 

 

  



 

Course Outcomes (COs) 

 

CO1 
Identify different CFD techniques available for relevant partial differential equations to 

predict analytical solutions for fluid flow. (Apply) 

CO2 
Select the type of flow from the finite control volume and infinitesimal small fluid element 

for the fluid flow analysis. (Analyze) 

CO3 
Develop the governing equations for computational fluid dynamics CFD analysis by setting 

appropriate boundary conditions. (Apply) 

CO4 
Carry out modelling, meshing and pre-processing as per the problem statement. 

(Imitation) 

CO5 Acquire data using the simulation tools from software. (Manipulation) 

CO6 
Perform basic post-processing techniques and represent the results in form of graph and 

table (Precision) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Mapping/Alignment of Cos with PO & PSO 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
PO1 PO2 PO3 PO4 PO5 PO6 PO7 PO8 PO9 PO10 PO11 PO12 PSO1 PSO2 

CO1 3 - - - - - - 1 - 2 - 2 3 - 

CO2 3 3 - - - - - 1 - - - 2 3 - 

CO3 3 - - - - - - 1 - - - 2 3 - 

CO4 3 - - - 3 - - 1 3 3 - 3 3 - 

CO5 3 - - - 3 - - 1 3 3 - 3 3 - 

CO6 3 - - - 3 - - 1 3 3 - 3 3 - 



 

List of Experiments 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. Model the laminar flow over a flat plate. 

2. Model the turbulent flow over a flat plate. 

3. Model the velocity boundary layer for internal flow. 

4. Model the convective boundary layer for internal flow. 

5. Model the flow over an airfoil moving at Mach 0.3, through air, 

at tropopause. 

6. Model the flow over a wedge/cone moving at Mach 1.5, through 

air, at an altitude of 15 km from the sea level. 

 

CO4, CO5, CO6 



Exp:1  Model the laminar flow over a flat plate 

 

Aim: To Model the laminar flow over a flat plate using ansys Workbench 

 

SOFTWARE USED: ANSYS FLUENT 

 

Steps Involved: 

1) Geometry design of the flat plate 

2) Constraining of the obtained geometry 

3) Selection of method in mesh- no of divisions-element size 

4) Providing Inflation with appropriate no of divisions and bias 

5) Providing the cell zone conditions and boundary conditions 

6) Initialization –Hybrid type 

7) Proving No of iterations  and run calculation 

8) Exploring the results  in the form of contours and plots. 

9) Pressure ,velocity can be calculated from the results obtained 

 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

 Results:  

                     Thus the flow over the laminar flat plate has been done using Ansys Fluent and 

the velocity and pressure have been calculated 

 

 



 

Exp:2                                     Model the turbulent flow over a flat plate. 

 

 

 Aim: To Model the turbulent flow over a flat plate using ansys Workbench 

 

SOFTWARE USED: ANSYS FLUENT 

 

Steps Involved: 

1) Geometry design of the flat plate 

2) Constraining of the obtained geometry 

3) Selection of method in mesh- no of divisions-element size 

4) Providing Inflation with appropriate no of divisions and bias 

5) Turn on Energy Equation and select k-epsilon turbulence model. 

6) Providing the cell zone conditions and boundary conditions 

7) Initialization –Hybrid type 

8) Proving No of iterations  and run calculation 

9) Exploring the results  in the form of contours and plots. 

10) Pressure ,velocity can be calculated from the results obtained 

11) The turbulent kinetic energy is calculated from the results 

 

 



 

 

 

 

 

 



 

 

 

 

 

 

 

 

 

 

 

 Results:  

                     Thus the turbulent flow over the flat plate has been done using Ansys Fluent 

and the velocity ,pressure ,turbulence kinetic energy have been calculated. 

 

 

 

 



 

Exp:3                                 Model the velocity boundary layer for internal flow 

 

 

Aim: To determine the flow in a cylindrical pipe or any cross section using ansys Workbench 

 

SOFTWARE USED: ANSYS FLUENT 

 

Steps Involved: 

1) Geometry design of the cylindrical  pipe  

2) Constraining of the obtained geometry 

3) Selection of method in mesh- no of divisions-element size 

4) Turn on Energy Equation and select k-epsilon turbulence model. 

5) Providing the cell zone conditions and boundary conditions 

6) Initialization –Hybrid type 

7) Proving No of iterations  and run calculation 

8) Exploring the results  in the form of contours and plots. 

9) Pressure ,velocity can be calculated from the results obtained 

 

 

 



 

 

 

 

  

 

 

 

 

 

 

 

 Results:  

                     Thus the internal flow over the cylinder has been done using Ansys Fluent and 

the velocity ,pressure have been calculated 

 

 

 

 



 

Exp : 4               Model the convective boundary layer for internal flow. 

 

 

Aim: To determine the flow in a cylindrical pipe or any cross section using ansys Workbench 

 

SOFTWARE USED: ANSYS FLUENT 

 

Steps Involved: 

1) Geometry design of the cylindrical  pipe 

2) Constraining of the obtained geometry 

3) Selection of method in mesh- no of divisions-element size 

4) Turn on Energy Equation and select k-epsilon turbulence model. 

5) Providing the cell zone conditions and boundary conditions(convective heat transfer)-

thermal  

6) Initialization –Hybrid type 

7) Proving No of iterations  and run calculation 

8) Exploring the results  in the form of contours and plots. 

9) Pressure ,velocity can be calculated from the results obtained 

 

 

 



 

 

 

 

 

 Results:  

                     Thus the internal flow over the cylinder with convective heat transfer has been 

done using Ansys Fluent , the results of temperature distribution is calculated 

 

 

 

 

 

Exp:5 Flow over an airfoil moving at Mach 0.3, through air, at tropopause. 

AIM: To simulate flow over NACA 0012 airfoil 

SOFTWARE USED: ANSYS WORKBENCH 

Problem description:  

Consider air flowing over NACA 0012 airfoil. The free stream Mach number is 1.2. Assume standard sea-

level values for the free stream properties: Pressure = 101,325 Pa Density = 1.2250 kg/m3 



 Temperature = 288.16 K 

 Kinematic viscosity v = 1.4607e-5 m2/s 

Steps Involved In CFD: 

Creation of Geometry :  Importing the Aerofoil coordinates File→Import Geometry→Formatted point 

data→Select the file of aerofoil coordinates which is in DAT format→ok. Now the coordinates will be 

displayed.  

 Geometry→Create/modify curve→From points→Select above points and leave last 2 points→middle 

click  

 Similarly on bottom side  

 Join the end points of the curves 

 

 



 

 



 

 

 



Problem setup:   

General→Type as: Pressure based  

Models→Energy ON→Viscous-laminar Materials→Air  

 Cell zone conditions→Type as: fluid→ok  

 Boundary conditions→Select inlet→Edit→Give velocity magnitude as: 400m/s.  

 Boundary conditions→Select outlet→Edit→Give gauge pressure as: 0 Pa 

 

Results: 

In Graphics and animations→select the required flow parameters in the contours and vectors for 

obtaining the required results. 

 

 

 

 

 

 

 

 

 

Exp : 5                                

 

 Model the flow over a wedge/cone moving at Mach 1.5, through  air, at an altitude of 15 

km from the sea level. 

 

AIM: To model the flow over a wedge/cone moving at Mach 1.5, through air, at an 

altitude of 15 km from the sea level. 

 

SOFTWARE USED: ANSYS WORKBENCH 

 

Creation of Geometry 
 



 

 

 

 

Creation of parts: 

 Parts in the tree→Right click→Create part→ 

Select Left curve: Inlet 

Select Right curve: Outlet 

Select Top curve: Top 

Select inclined curve: Wedge 



Select bottom curve: Front_wedge 

 Saving the Geometry: 

 File→Change working directory→Choose the folder 

 File→Geometry→Save Geometry as→Give the name. 

Creation of Blocking and Association: 

 Blocking→Create block→Initialize blocks→Type as:2D Planar→ok 

Associate→Associate vertex to point→Select a vertex and a point→Apply→ 

Similarly associate remaining 3 vertices to points 

 Associate→Associate edge to curve→Select a edge and a curve →Apply→ 

Similarly associate remaining 3 edges to 5 curves 

Generation of Mesh: 

Pre-mesh parameters→Edge parameters→Switch ON the Copy Parameters→ 

Select the Horizontal edge and give no. of nodes as: 100→ok 

 Pre-mesh parameters→Edge parameters→Switch ON the Copy Parameters→ 

Select the Vertical edge and give no. of nodes as: 100→Spacing as: 

0.001→Ratio as: 1.1→ok 

 

 

 

 

 

Model the laminar flow over a flat plate 

AIM: 

To model the laminar flow over a flat plate. 

 

 

 

 

 


